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PREFACE 

 
This document is intended to accompany copies of the Arizona Local 
Government Safety Project Implementation Model (AzLGSP), distributed by the 
Arizona Transportation Research Center, Arizona Department of Transportation.  
The AzLGSP is intended to facilitate hazardous site identification on roads under 
local government (i.e. cities, towns, counties) jurisdictions.  Users are provided 
with a self-extracting copy of the model (azlgsp-2.exe) and this document on 
floppy disk, and crash data reference files on CD. 
Users are encouraged to report any problems discovered in the program to the 
ATRC.  Any questions, comments or concerns should be directed to:   
John Semmens  jsemmens@dot.state.az.us (602) 712-3137 
Jason Carey   jasoncarey@hotmail.com  (916) 482-1478 
 
Users are encouraged to review this document prior to working with the AzLGSP 
model.  
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SOFTWARE INCLUDED 

 
Each recipient has been provided with a floppy disk containing a copy of the 
Arizona LGSP model as a self-extracting archive "azlgsp-2.exe” and a copy of 
this document. 
Each user has also been provided with a “CRASHDATA” CD containing 15 crash 
data files (one for each county) from 1995 to 2000.  The crash data files are 
Microsoft Access 97 databases (filename.mdb) named according to county.  For 
example, Apache County data are located in the file “Apache.mdb” 
Note that the CD distibuted in the initial training session held on March 18, 2002 
contains a beta version of the AzLGSP model.  This version is fully functional, 
except for the export routines that send crash details to MS Excel.  The CD 
version should be replaced with the version distributed on floppy disk. 
After running azlgsp-2.exe, the Arizona LGSP model will be installed on the 
user’s hard drive.  The county data files can be left on the CD or copied to a local 
network, from which they can be accessed via the Linked Table Manager 
function.  The How To Load LGSP model section illustrates the procedure for 
loading the Arizona LGSP model; and the Getting Started section discusses 
preparing the model for use. 
Users more familiar with the LGSP model may wish to skip to instructions for a 
particular screen view with which they are working.  For ease of reference, 
thumbnail view of the more common screen views are shown on the following 
page.  Clicking on any of these screen pictures will take the reader to the section 
of this document discussing that particular screen.
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INTRODUCTION 
 
The Arizona Local Government Safety Project Model is a tool that can be used to 
facilitate the selection of hazardous roadway locations in local jurisdictions, to 
prioritize those locations by rational means, and to aid in the evaluation of 
potential spot treatments of safety hazards.  However, the model is not intended 
to automate the entire decision-making process, and can not substitute for the 
analysis and judgment of a traffic engineer. While Arizona LGSP Model should 
prove to be a useful tool, particularly for jurisdictions with limited research 
budgets or capabilities, use of the model is not mandatory, and is subject to the 
preference of each jurisdiction. 
 
The Arizona Local Government Safety Project Implementation Model (LGSP 
model) was created in MS Access 97.  The model consists of a self-contained 
query and reporting database, and a supplemental database of crash records on 
CDROM.  Running the model requires the following hardware and software: 

• Microsoft Office 97 or newer: Access, Word and Excel programs 

• MS Access must be loaded with the “Linked Table Manager” add-in 

• CDROM drive or network access 

• Approximately 32Mb RAM and 100Mb hard disk space 
 
The model is computation-intensive, and will require a significant amount of time 
to run on machines with slower processors.  On slower processors, it is 
particularly important that additional programs be closed while the update is 
being run.  The amount of time required for a complete update of the model will 
vary with the power of the machine used, the speed of CDROM or network data 
transfer, and the size of the jurisdiction(s) being analyzed.  It is recommended 
that smaller units of analysis (e.g. a single city rather than an entire county) be 
examined separately whenever possible. 
 

MODEL OVERVIEW 
The Arizona LGSP Model is basically divided into two processes.  The first 
selects a subset of hazardous locations from one or more jurisdictions based on 
user-defined parameters.  These locations are prioritized according to one of 
several measures of hazard or severity, and multiple reports are generated to 
summarize crash incidence, roadway and driver characteristics, and estimated 
costs associated with each location.  The second component of the LGSP model 
prompts the user for possible safety treatments for one or more locations, 
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calculates the expected benefits for each project, and returns a benefit-cost 
analysis that follows HES eligibility guidelines.    
 
The LPSG model stores crash location data until another update is run.  Although 
the data stored takes up a substantial amount of hard disk space, storage 
facilitates the update process, providing faster access to jurisdiction-specific 
crash subsets and allowing the user to test alternate safety treatment scenarios 
without rerunning the model.  The two-step procedure takes the following form: 
 
 
 
 
 
 
 
 
 
After the user specifies site selection parameters, a series of queries are run on 
the database to extract, sort and aggregate jurisdictional crash records.  From 
this procedure,  a series of reports are generated.  These reports identify the 
highest-priority site locations, summarize such information as the frequency, 
severity and cost of crashes at each location, provide specific details of roadway 
type, condition and relationships; vehicle actions, speeds and harmful events; 
and external factors such as weather.  The LGSP model generates a report 
listing comparable sites for a specific location, allowing the user to perform 
statistical analyses of relative risk and regression-to-the-mean if needed.  These 
data are also useful for before-and-after comparisons of treated and untreated 
locations.  From various report outputs, it is expected that local traffic engineers 
will be able to identify target sites for mitigation. 
Prior to input of safety project alternatives, it is assumed that each potential site 
will be subjected to greater study, identifying relevant information not provided by 
the LGSP model.  Site engineering studies and surveys of prior treatments are 
necessary for determining feasibility of improvements at a treatment location. On-
site analysis provides the most reliable assessment of influential factors at a 
project location, and should identify far more site characteristics than an 
automated review of crash data.  Although some degree of inference regarding 
potential safety improvements can often be made from the LGSP outputs, these 
reports are not intended to supplant a rigorous on-site evaluation.  
Once the target sites have been evaluated, it is expected that one or more 
improvement projects will be identified as appropriate for the site conditions.  At 
this point, projects can be entered in the LGSP model and evaluated in terms of 

Query 
existing 
crash data 

Crash 
Data 

Specify site 
identification 
parameters 

Create 
site 
reports

Input safety 
project 
alternatives

Create 
project 
reports

External: 
Site 
analysis 



 

 6 
 

a benefit-cost analysis.  Each project alternative is assigned expected levels of 
effectiveness for reducing crashes at the site location.  Effectiveness measures 
(crash reduction factors) can be assigned by the user, or default values 
generated by the model can be used when available.  The effectiveness 
measures are combined with crash frequency measures to yield an overall 
reduction in crashes of varying severity at each location.  This reduction is then 
multiplied by the cost associated with a crash of that severity to yield an annual 
benefit.  Annual project benefits are compared with the annualized costs of 
implementing the safety improvement to yield a benefit-cost ratio. 

CAPABILITIES 
The Arizona LGSP Model can accomplish the following tasks: 
 

• Analyze multiple jurisdictions 
• Limit crash records returned based on user-defined parameters 
• Aggregate crash records based on distance from a specific location 
• Provide total and annualized crash details, including: 

• Frequency/incidence 
• Units involved 
• Severity (highest observed for each record) 
• Severity (injuries for each person involved) 
• Estimated costs associated with crashes 
• Summary statistics for incidence measures 

• Summarize crash details and limit details to a specific subset 
• Provide a list of sites comparable to the chosen site of analysis 
• Accept and analyze user input of traffic volumes at multiple sites 
• Analyze multiple safety projects at a location 
• Rank order project alternatives by cost effectiveness 
• Format project details to supplement HES eligibility applications 

 

LIMITATIONS 
The Arizona LGSP Model does not do the following: 
 

• Provide traffic data for a given site, though user inputs for these data 
can be analyzed 

• Know the site history (i.e. which treatment alternatives have been 
evaluated or implemented in previous years) 

• Automatically update crash cost estimates, though these can be 
modified by the user from the STARTUP page 

• Automatically update the crash records file, though instructions for 
performing this action using an automated format are included in 
Appendix B 
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HOW TO LOAD 
1. Insert the disk containing the azlgsp-2.exe file in the appropriate drive.  This 

example uses drive letter E:\   For other drive locations, simply substitute the 
appropriate drive letter. 

2. From the Windows desktop, select START > RUN 
3. The following dialog box will be displayed. 

  
4. Select “Browse” to choose the location of azlgsp-2.exe 
5. A new dialog box will be displayed (see below).  Select the drive used in Step 

1. at the top of the page, choose the “azlgsp-2.exe” file, and press “Open.” 

 
6. The first dialog box should now read “Open: E:\azlgsp-2.exe”.  Press “OK” to 

load the model. 
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FILE LOCATIONS 
Three files will be extracted to the user’s hard drive, and a new folder will be 
created for these files at C:\ADOT\SFTYMDL.  
DO NOT change this directory; the model will not work properly if the file 
locations are altered.  After extracting, verify that all files exist in the new 
directory: 
 
C:\ADOT\SFTYMDL\AzLGSP2.mde (operating version for Access 97) 
C:\ADOT\SFTYMDL\AzLGSP2.mdb (updatable version for conversion) 
C:\ADOT\SFTYMDL\SFTYDATA.mdb (storage file for query results) 
 
The only difference between .mde and .mdb versions of the model is that the 
.mde format does not allow alterations to the macros and forms built into the 
model.  It is recommended that users of MS Access 97 run the AzLGSP2.mde 
file to avoid any unintended changes to the file structure and routines. 
Users of newer versions of MS Access may wish to convert the model to the 
newer version.  Files with the .mde extension can not be converted to newer 
versions.  In this case, the AzLGSP2.mdb file should be used. It is recommended 
that users of newer versions of Access create a new .mde file after converting. 
If AzLGSP2.mdb is opened in Access 2000, the user will be asked whether or not 
to convert the file to Access 2000.  Select “yes”/”ok” and Access will perform the 
conversion.  Reopen the new file and select Tools > Database Utilities > Make 
MDE File to create a new .mde version of the model. 
Rather than storing internally all jurisdictional data returned from the crash data 
CD, AzLGSP.mde sends these data to the SFTYDATA.mdb file.  The data tables 
are linked to AzLGSP.mde, but do not increase the size of the file. Running the 
model again simply replaces the tables in the SFTYDATA.mdb file, without 
affecting the links in AzLGSP2.mde.  If AzLGSP2.mdb is converted to Access 
2000 (or later versions), it is recommended that SFTYDATA.mdb be opened and 
converted as well.  Other than for conversion, or to fix occasional replacement 
errors, there should be no need to modify the SFTYDATA.mdb file.  
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GETTING STARTED 

When opened, the LGSP model first displays two messages for the user.  The 
first message box is a reminder that the CD containing crash records must be 
loaded for the model to function properly.  Previously generated reports may be 
viewed without the CD, but no new analyses can be completed without the crash 
data files. Users that have stored crash data on a network drive may ignore this 
warning. 

 
The next message that appears is a reminder to compact the database 
periodically. To compact the database, let the STARTUP screen (see below) 
load, and then  

 
 
NOTE: The first time the model is opened, the crash data tables will need to be 
updated before use. To update all linked tables, use the Linked Table Manager 
located in Tools > Add-Ins > Linked Table Manager. 
The LGSP model should be accessed using the buttons shown on each screen 
whenever possible.  For example, the “EXIT Program” button will close the 
database from the STARTUP screen, and other forms contain an “EXIT to Start” 
button that will return the user to the STARTUP screen.  For additional 
discussion, see the Basic Navigation section. 

 

STARTUP FORM 
 
Once the database has been opened, and compacted or refreshed as necessary, 
the STARTUP view form will appear (Figure 7).  This form provides an outline of 
the available procedures in the LGSP model, and will reappear at the end of 
each option procedure chosen.  
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Prior to selecting options from the STARTUP form, it is recommended that three 
procedures be followed to so that the model runs properly: 
i. Update the Linked Table Manager 
ii. Compact the AzLGSP and SFTYDATA databases 
iii. Verify that the Crash Costs used are current 
 

 
From the STARTUP outline, the following choices can be made: 
1. Run the entire update and prioritization procedure to select potentially 

hazardous sites.  This option also allows the results of a previous update to 
be re-sorted by new parameters.  Pressing Button 1 will open the INPUTS 
form. 

2. Buttons 2a and 2b open summary reports for the most recent run of the 
model.  Button 2a opens the PRIORITY LIST report, which summarizes the 
top twenty-five hazard locations, sorted by the parameters selected in the 
previous update.  Button 2b opens the RECORD LIST report for the 
locations summarized in the PRIORITY LIST.  The RECORD LIST contains 
individual summaries for each crash record at a high-priority location.   

3. Button 3 is linked to multiple options for viewing and/or exporting crash record 
details.  Pressing Button 3 opens the Location Details (LOC_DTL) form, in 
which additional options are presented.   
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4. Button 4 opens the Safety Project Details form, used to input safety project 
ideas once sites and potential treatments have been identified. 

5. Button 5 opens the Project Evaluation Report containing an analysis of 
effectiveness and benefits versus costs for project entered in option 4. 

 

DATABASE UTILITIES 
Because many of the AzLGSP queries rewrite data tables, the file will grow each 
time it is run.  Compacting the database will condense empty spaces (deleted 
tables), reducing the size of the file and improving performance. 
To compact the AzLGSP file, select Tools > Database Utilities > Compact 
Database from the menubar, as illustrated in the following figure.  After a brief 
period, the model will automatically re-open, ready for use. 
In addition to compacting the AzLGSP file, the SFTYDATA.mdb file will need to 
be compacted regularly, as this file will grow with each iteration of the model.  For 
compacting the SFTYDATA file, a button has been added to the STARTUP 
window in AzLGSP2, circled in the figure below.  Simply press this button to 
compact the SFTYDATA.mdb file, saving hard disk space.   
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LINKED TABLE MANAGER 
The first time the model is opened, the crash data tables will need to be updated 
before use. To update all linked tables, use the Linked Table Manager located in 
Tools > Add-Ins > Linked Table Manager.   

 
 
This will open the linked table dialog box shown below.  To link crash data from 
the county to be analyzed, press the “Select All” button and the check the box 
for “Always prompt for new location”.  These are highlighted on the dialog box 
below.  
DO NOT press "OK" yet.  First, clear the check marks from the following tables 
shown in the dialog box: 

• LOCATION 
• LocationTable 
• PRIORITY DETAIL 
• PRIORITY LIST 

• Table2d 
• Table3 
• Table4 

 
Note that the tables are grouped alphabetically, with the first four appearing in 
the middle of the dialog box, and the last three appearing at the end.  These 
seven tables should always be linked to C:\ADOT\SFTYMDL\SFTYDATA.mdb 
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 CLEAR CHECK BOXES! 
 
After clearing the checkboxes for the seven reference tables located in 
C:\ADOT\SFTYMDL\SFTYDATA.mdb, press the “OK” button.  A new location 
dialog box will appear.   

 
 
Because all linked files are located in the CRASHDATA file, the remaining tables 
will automatically be refreshed. 
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If any of the seven tables from C:\ADOT\SFTYMDL\SFTYDATA.mdb are 
included in the update (i.e. if the check boxes are not cleared from these tables), 
an update error will occur.  The error will force the tables to be updated 
individually, rather than as a group.  The “Select New Location” dialog box shown 
above will appear for each table in the update procedure.  Pressing “Open” will 
only link one table at a time.   
Because this process is very time-consuming, the best response is not to 
continue the update.  Press “Cancel” to close the new location dialog box.  
Restart the Linked Table Manager, ensure that the tables from SFTYDATA.mdb 
are not selected (i.e. check boxes are cleared), and try the update again.  
This process must also be completed each time a new crash data file is to be 
analyzed.  For example, if the user wishes to replace “APACHE.mdb” (i.e. the 
Apache County data file) with a new file “YUMA.mdb,” the tables must be 
refreshed with the new file name.   
The crash data files have been subgrouped according to county level jurisdiction 
in order to improve the processing time of the LGSP model.  Interested users 
may also obtain complete data for 5-year periods contained in a single file from 
the ATRC.  However, use of the county-level databases is strongly encouraged, 
particularly for smaller counties, as these files reduce run time by 90 percent or 
more. 
Once the reference files for the jurisdiction of interest have been updated in 
Linked Table Manager, the AzLGSP model will be ready to generate site reports.  
Closing the Linked Table Manager will return the user to the STARTUP page. 
 

COST DATA 
In addition to the five STARTUP options in the numerical outline, the user can 
also adjust the cost estimates for crashes of varying severity used in the benefit-
cost analyses.  This procedure should be done prior to running a new update.  To 
access the crash costs page, press the “Cost ADJ” button circled on the 
STARTUP form shown above.   
The COMPCOST form, shown below, will be opened.  This form allows the user 
to adjust the average estimated total cost of a crash depending on the maximum 
severity observed.  The format follows the HES eligibility guidelines used by the 
Arizona Department of Transportation.  These figures are posted on the Internet, 
and are also available from ADOT Traffic and Engineering. 
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After adjusting crash costs as necessary, the “Exit” button (circled above) will 
return the user to the STARTUP page.  
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USING THE ARIZONA LGSP MODEL 

 
This section will follow the procedures for a complete update from start to finish.  
Sections can be accessed from the Quicklinks list or the Screen ID links at the 
top of this document. 
Pressing Button 1 on the STARTUP page opens the INPUTS form, which allows 
the user to specify criteria for selection of hazardous roadway sites.  Each option 
is linked to a reference table, and the option selected is copied to the INPUTS 
table.   

INPUTS: CREATING A SITE LIST 
 

 
 
To create a list of high-priority (i.e. hazardous) sites, the user must specify a 
jurisdiction of analysis.  This can be a county, a city or town, or reservation.  In 
checkbox below the Jurisdiction menu, the user can specify whether to include 
cities and towns in the county-level analysis.  For example, to include all 
jurisdictions in Gila County, the Include sublevels option would be set to “Yes.”  
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Start and end dates must be entered in numerical format.  In most cases, no 
more than five complete years of data will fit on a crash data CDROM.  However, 
if the program is run over a network, there is no limitation on the number of years 
of data that could be included on a server-based crash data file. 
 
To exclude alcohol-related crashes, type “No” in the appropriate box.  To 
include all crashes, type “Yes.”  The default value for this option is “No.” 
 
The Location Method menu provides four options for identifying a crash site, all 
of which rely on cross streets to identify the reference point.   

• Route method limits a site to crashes occurring on one route at a junction 

• Junction method aggregates all crashes at a junction regardless of route 

• Junction-related refines “Junction” method to include only junction crashes 
classified as related to the junction and/or intersection 

• Intersection-related refines “Junction” method to include only junction 
crashes specifically related to the intersection 

 
After specifying the site identification method, the aggregation distance must be 
selected.  Aggregation distance refers to the radius from the cross street 
reference within which crashes will be included at that site.  For example, 
selecting “500 feet” will include all crashes referencing a particular junction that 
occurred no more than 500 feet from that junction.  
 
Finally, the user must specify the reporting method criterion used to prioritize 
hazardous locations.  Again, four options are provided: 

• Total Incidence prioritizes sites by the number of crashes (of any severity) 
observed in the period of analysis  

• Total Fatalities prioritizes sites by the number of fatalities observed at each 
site; crash counts are used to weight sites with no fatalities  

• Total Fatalities + Injuries option filters injurious locations by ordinal 
measures of severity; crash counts are used to weight sites with no injuries 

• Weighted by Severity option is similar to the “Total Fatalities + Injuries” 
option, except that the relative magnitude of severity in terms of crash costs is 
considered in place of ordinal mneasures 

 
Once the user inputs have been specified, the GET RESULTS button will run the 
prioritization procedure (the TRAFSAF macro).   This process can take anywhere 
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from 2 minutes to several hours, depending on the jurisdiction(s) selected an the 
speed of the computer used.  When the TRAFSAF macro begins, the following 
message will be displayed: 

 
Because the macro rewrites existing tables, the program will ordinarily verify that 
the previous information should be deleted.  These verification messages will 
appear every few minutes while the model is running, and will stop the update 
until the user responds.  By selecting the “YES” button, the delete warnings will 
be temporarily disabled while the TRAFSAF macro runs.  This option speeds up 
the site identification procedure and allows the user to avoid constant monitoring 
of the update process.  A notification message will still appear approximately 
halfway through the update to document progress thus far.   
If the “YES” button is selected, the database windows will minimize and the 
LGSP model will appear inactive for some length of time.  Again, it is 
recommended that no other programs be run until the PRIORITY LIST 
report appears at the end of the update. 
 

MODIFYING RESULTS 
After the initial run of the TRAFSAF macro, jurisdiction locations can be re-
queried for new aggregation distances or reporting methods without running the 
entire procedure again. The macro action buttons next to the Aggregation 
Distance and Reporting Method menus can be used to re-sort existing locations.  
The time savings from using this method is greater than 50 percent.  For 
example, if “intersection-related” crashes for Quartzite were initially queried using 
a 500-foot aggregation distance and prioritized according to total fatalities, these 
data could be requeried using a 100-foot distance to determine which crashes 
occurred within the smaller radius from the intersection.  Similarly, crashes at 
these sites could be re-prioritized according to different severity measures (e.g. 
total incidents, total number of persons harmed, etc.). 
To re-query existing data, simply change one of the Distance or Reporting 
parameters in the menus on the STARTUP page.  Then press the “Re-sort 
existing records” button for the category changed.  A new PRIORITY LIST will be 
generated using the new parameters. 
No other changes should be made prior to running these procedures.  For 
example, changing the Location Method will cause the program to return invalid 
and/or incomplete data.  These options are intended to facilitate the examination 
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of existing data for a variety of scenarios, and should only be used after a full 
update procedure has been completed. 

VIEWING RESULTS 
When the TRAFSAF macro has finished running, the PRIORITY LIST report will 
be displayed.  If an update has already been completed, the PRIORITY LIST 
report can also be accessed by pressing Button 2a on the STARTUP menu. As 
shown in the following figure, the PRIORITY LIST summarizes the results of the 
local site prioritization procedure, returning the twenty-five most hazardous 
locations as defined in the user inputs section.  Locations are ranked by 
jurisdiction in descending order of importance as specified in the “Reporting 
Method” option.  Crash incidence and severity measures are included for each 
location. 
 

 
 
The PRIORITY LIST report can be printed or closed from the preview screen, but 
can not be modified.  Closing the report returns the user to the STARTUP menu.  
If greater detail is required for the location summary, Option 2b can be run to 
open the Priority Location Record List.  This report contains the same site 
location references as the Priority List, but each individual crash record is 
represented along with costs for each crash sorted by year of analysis. 
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The Priority Location Record List is also useful for gathering any additional data 
that may be required.  Because crashes are indexed according to record number, 
a list of records provides a simple means of identifying items of interest.  
However, the record list report does not provide substantially different information 
than the Priority List report, and is intended only as a supplemental reference to 
be used as needed.  Because the record list report can be quite long (e.g. 
records for Gila County locations shown in Figure 11 take up 19 pages), it is 
recommended that printing be done from the file menu (File > Print) and then 
specific page numbers selected for printing.   
 

 
 
As in the case of the Priority List report, closing the Priority Location Record List 
will return the user to the STARTUP menu.  In the case of a complete update, the 
next step would be the examination of individual crash details for one or more 
locations. 
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BASIC NAVIGATION 
It is strongly recommended that buttons included on forms (e.g. STARTUP, 
INPUTS, SITE DETAILS, PROJECT DETAILS and PROJECT EVALUATION) be 
used to move between screens.  These forms all contain buttons to move 
between records, perform update functions, and return to the previous or 
STARTUP form.   
All forms can also be closed using the lower “X” (close form) box in the top right 
hand corner of the form. Closing a form in this manner will return the user to the 
STARTUP screen.  This procedure can be used to close a blank form in the 
event that the user has omitted data prior to running a query. For further 
discussion, refer to the ERROR: NO DATA discussion for incomplete safety 
project entries. 
To navigate reports (e.g. Priority List, Priority Records, Crash Details), use 
options on the lower menu bar to manipulate the report.  The report can be 
resized, printed, closed or exported to other MS Office programs from this menu 
bar.  These options are highlighted in blue on the figure below. 

 
In most cases, if a form or report does not display, open or close properly, simply 
compacting or closing the database will solve the problem. 
 



 

 22 
 

CRASH SITE DETAILS 
 
Pressing Button 3 (marked with an arrow) on the STARTUP menu takes the 
model user to the Record Details form shown in below.  Several viewing options 
are available for individual crash records.  

 
 
The most complete data are available by selecting the “Details for each crash” 
option for all Priority List locations (a.i.), all locations where fatal crashes 
occurred (a.ii.), or a specific location chosen from the Priority List (a.iii.).  These 
options will create one-page reports for each crash record, listing recorded 
details on roadway, driver, incident and vehicle characteristics.  A sample report 
is shown below. 
Additional procedures that can be run from this page include creating a one-page 
summary of all crashes at a particular location, exporting crash details to an 
Excel spreadsheet (useful for Pivot Table reports and other custom summaries), 
and generating a list of other sites in the jurisdiction with similar characteristics.  
The latter procedure can be used to include traffic counts in the comparitive 
analysis. 
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EXPORTING DATA  
Due to the number of crashes at many sites, the detail reports can be tedious to 
examine, particularly in the case of option a.i.  “All Priority List locations.”  Items 
b.i. and b.ii. are intended to facilitate the use of the information contained in the 
detail reports.  Selecting either of these buttons will automatically export crash 
details to an Excel spreadsheet.  The export options have been pre-formatted to 
simplify analysis (e.g. record subtotaling by route, harmful event(s), etc.), and will 
automatically write to the following location: 
 C:\ADOT\SFTYMDL\SFTYPROJ.XLS 
 
Note that the data transfer takes less than two minutes, but the spreadsheet will 
not automatically open.  The following dialog box will appear as a reminder of the 
export file location when one of the b. options is chosen. 
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In addition to the crash details export capability, the LGSP model can also 
produce a summary of many crash details for a single location.  This option can 
be accessed by pressing the “Summary of Location Details” button after 
choosing a location in option iii.  The summary report form will be generated after 
a run-time of approximately two minutes.   

SUMMARY RESULTS 
The Location Detail Summary Report subtotals a number of crash details for the 
chosen location, and return such information as crash counts per route, average 
distances from the reference junction, average vehicle speeds and posted speed 
limits.   

 
This form can be printed in a one-page layout by selecting the print option at the 
top of the screen.  It should be noted that counts for different variables will not 
always match the number of crashes.  This occurs because some variables are 
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recorded for each vehicle (e.g. unit action and violation), while others pertain to 
the site (e.g. traffic way and grade). 

COMPARISON SITE LIST 
The final option available for crash location detail reporting is the Comparison 
Site List, also located in section a.iii.  The Comparison Site List report returns a 
summary of additional sites in a jurisdiction that have similar characteristics to 
the site location being analyzed.  This report is intended to facilitate before-and-
after comparisons between treated and untreated locations, and to provide basic 
statistics for estimating regression-to-the-mean potential at a given site.   
Selection Criteria 
The Comparative Site List identifies other locations in the jurisdiction that match 
the following criteria from the reference location:   

• junction and intersection relationships  

• traffic way and roadway characterisitics  

• special locations (e.g. pedestrian crosswalks) 

• traffic control devices 

• maximum posted speed 
Depending on the characteristics of the reference location, the number of sites 
returned can range from none to several hundred.  The Comparative Site List 
generates summary statistics (average annual crash incidence and standard 
deviation) for all sites in the report.  Analysis of any location subsets is left to the 
user of the model. 
Two different Comparison Site List reports can be generated.  The only 
difference between them is that one report contains crash rate data using 
average daily traffic (ADT) counts entered by the user.  When the Comparison 
Site List button is selected in details section iii., a message box will appear, 
asking whether the user would like to include traffic count data.  If the “No” button 
is pressed, no further action is required.  A summary list of related crash 
locations is generated (see Comparative Sites Report A – No Traffic Data).   

 
If the “Yes” button is pressed, another message box will appear, this time asking 
whether traffic counts need to be added or modified.  If traffic counts have 
already been entered, pressing “No” will open the Comparison Site List 
containing ADT counts, crash rates for each location and summary statistics for 
the crash rates measurements (see Comparative Sites Report B – Traffic Data).  
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Note that crash rates are expressed in terms of annual crashes per 10,000 
passing vehicles. 

 

TRAFFIC COUNTS 
Pressing “Yes” on the second dialog box will open the Comparative Sites Traffic 
form shown below.  This form allows the model user to enter average daily traffic 
counts for any or all locations in the comparison site report.  Average daily traffic 
counts can be based on any period, but must reflect daily figures.  The LGSP 
calculates annual crash rates per 10,000 passing/entering vehicles using the 
following formula:  
  AnnualCrashRate = AnnualCrashes * ADT * 365 / 10,000 

 
 
Note that it is not necessary to enter traffic counts for all sites.  The LGSP model 
calculates crash rate statistics based only on the sites for which traffic counts 
have been entered.  Leaving some sites blank will not affect the calculation of 
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statistical outputs (comparison sites average and standard deviation).  However, 
the more sites for which traffic counts are included, the more reliable the 
forecast.   
*WARNING*  Crash data will only be stored for the location most recently 
selected in the Record Details Form.  Changing the location and then choosing to 
enter traffic data will delete traffic data for the previous location.  Printing or 
copying traffic data is strongly recommended prior to analyzing a new site.   
Once traffic counts have been entered, pressing the “Get Report” button in the 
Comparative Sites Traffic form will open the Comparison Site List that includes 
traffic-adjusted crash rates.  Refer to the following page for illustrations of the two 
Comparison Site reports.  Closing either Comparative Site List will return the user 
to the STARTUP menu. 
To recount the traffic-related and non-traffic-related comparison options, select 
Option 3 from the STARTUP menu, then press the Comparison Site List button in 
Record Details Form section iii.  At the first message box, press “No” to view the 
report that does not contain traffic data.  Press “Yes” to continue to the second 
message box.  At the second message box, press “No” to view the report 
containing previously entered traffic data.  Press “Yes” to modify traffic data in 
the Traffic Data Input form. 
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Comp Site Report: No Traffic 

 
Comp Site Report: Traffic 
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SAFETY PROJECT SELECTION 
In most cases, additional studies and site analyses will be required before 
proceeding to Option 4: Input of Potential Projects.  The Priority List and various 
detail reports provide a means of identifying hazardous sites and enough 
additional information to form hypotheses about the appropriate site treatments.  
However, these details do not supplant the need for on-site evaluation(s) by local 
traffic engineers.  Once a field evaluation has been performed for one or more 
hazardous sites identified in Options 1 – 3, it is assumed that several potential 
safety treatments will have been identified for these locations.  Option 4 provides 
an input form for potential safety projects, which can then be evaluated in terms 
of expected effectiveness and associated benefits versus project costs. 
 

PROJECT DETAILS FORM 
Pressing Button 4 on the STARTUP menu opens the Safety Project Details 
form.  Any number of safety projects can be evaluated from this page.  However, 
each project must be assigned a unique “Project Number” identifier prior to 
analysis.  It is recommended that the “Alternatives” fields also be used to 
distinguish between multiple possibilities at the same location.  A site location 
must be selected from the “Project Location” menu – omitting this step will cause 
the project data to be ignored, and a blank error form to appear when the sites 
are evaluated (see NO DATA ERROR below).   
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The remaining inputs for a preliminary project assessment are listed below.  Note 
that some fields are required inputs, while others may be left blank. 
On Route: specify which route at the project location will receive the safety 
treatment 
Project Type: select from the menu of 76 different project types organized by 
seven broad project classes; an “other safety improvements” category is also 
provided in the event that none of the available types are suitable; this field is 
used to assign default values for project life cycle and estimated effectiveness 
(required) 
Project Description:  enter a brief but specific description of the safety 
treatment; this field will help discern multiple treatments at the same site and is 
included in the Project Evaluation report  
Total Construction Cost: enter the total estimated implementation cost of the 
project; do not annualize this figure – the model will perform this calculation 
(required) 
Annual Maintenance Cost: enter the annual cost (if any) of operating or 
maintaining the treatment; only include costs that are not reflected in the “Total 
Construction Cost;” for example, include the annual cost of periodic repairs to 
crash cushions after construction 
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Project Life: enter the expected life span of the safety improvement in whole 
years; the model will assign default values based on the Project Type; this field is 
only required if defaults are not available for the Project Type selected 
Interest Rate: enter the interest rate used to annualize costs by calculating 
capital recovery factors; as in all term-based financing, the higher the interest 
rate, the more expensive the project; the model currently uses a range from 8 
percent to 16 percent per HES guidelines 
Project Effectiveness: enter expected crash/accident reduction factors for 
crashes of each severity class; this field is not required for the preliminary 
analysis – when available, the LGSP model will assign default values if these 
fields are left as “0”; note that the final estimate of effectiveness is the 
responsibility of the model user, but these figures can be adjusted in the next 
step 
 
When entering multiple projects, use the “Next Record” and “Previous Record” 
arrow buttons to move from screen to screen.  For example, after entering 
Project #1, press the “Next Record” button to view a blank screen in which 
Project #2 can then be entered.  To edit Project #1, simply press the “Previous 
Record” button to back up one input screen.  Once all projects have been 
entered, press the “Evaluate” button in the bottom right corner of the screen.  
This will activate a Project Evaluation macro, and after several minutes (generally 
less than three) the Project Evaluation Form will be displayed. 
 

SAFETY PROJECT ANALYSIS 
Project benefits are annualized using historical crash rates, crash cost figures 
and effectiveness parameters.  It should be noted that, regardless of estimated 
effectiveness, the benefits associated with a safety improvement will be 
constrained by average incidence rates for each type of crash.  Annual benefits 
are calculated by multiplying the annual crash rate by the reduction factor to yield 
a “Total Annual Reduction,” which is then multiplied by the estimated cost of 
each type (i.e. severity) of crash to yield the “Annual Benefit” estimate.  Safety 
project costs are annualized in a similar manner.   
Depending on the interest rate and life cycle of the safety improvement, an 
appropriate capital recovery factor is assigned.  The capital recovery factor is 
multiplied by the total construction cost to yield an annual construction and/or 
implementation cost.  Annual maintenance costs are then added to the 
annualized construction costs to calculate the “Total Annual Project Cost.”   
The “Total Annual Benefit” and “Total Annual Cost” figures are compared in the 
“Project Summary” section on the right side of the form.  Dividing total annual 
benefits by total annual costs returns a project benefit-cost ratio.  If this figure is 
greater than 1.0, the project is within the range required for HES funding 
eligibility.  However, this does not imply that projects are automatically eligible for 
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HES funds.  A completed application must be submitted and approved prior to 
funding. 

PROJECT EVALUATION FORM 
The Project Evaluation Form contains a preliminary benefit-cost analysis and 
associated estimates of effectiveness for each project entered in the Project 
Details form.  Projects are displayed individually, and may be viewed by using 
the “Next Record” and “Previous Record” buttons.  As shown in the figure below, 
each project view contains a summary of project number, type, class, location 
and description.   

 
 
Once the evaluation procedure has been run, the user has the option of editing 
existing projects and/or adding new projects or creating a final Project Evaluation 
Report. These options can be chosen via the buttons located in the bottom right 
corner of the Project Evaluation Form.  If the “Edit/Add” button is selected, the 
user will be returned to the Safety Project Details form.  If the “Report” button is 
chosen, the model creates the report shown in the following section (STARTUP 
Option 5). 
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ERROR WARNING: NO DATA 
If the Project Evaluation form is a blank screen (see figure below), the user has 
not specified a site location in the Project Details form.  Close the Evaluation 
form by clicking lower “X” (close window) button, shown in the figure below.   This 
will close the current form and return to the STARTUP form.  Select Option 4 to 
return to the PROJEC 

 
 

PROJECT EVALUATION REPORT 
The Safety Project Evaluation report can be accessed through the previous step, 
or by selecting Option 5 from the STARTUP menu.  This report contains the 
same data as the Project Evaluation form, formatted for printing.  A Project 
Evaluation report should be accompanied by the Priority List, Location Details 
and/or the Detail Summary, as well as the Comparative Sites report.   
Additional data are required for HES applications.  The LGSP model outputs can 
be used to support an application, but traffic, engineering and historical treatment 
analyses are also required for an HES program application. 
 

Click the lower X 
to close this 
window and 
return to the 
STARTUP page 
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Use of the LGSP model need not be confined to spot treatment analyses.  
However, the availability of funding for spot improvements makes it likely that 
these projects will be the primary focus for most LGSP users.  In cases where 
treatments are limited in scope or area of influence, it is recommended that 
multiple iterations of the model be run using different aggregation distances.  For 
example, while a guardrail installation may conceivably affect a large stretch of 
highway, the relocation of a utility pole has a much more concentrated impact 
area.  Whereas an aggregation of crash data within a 500-foot radius may be 
appropriate for the guardrail evaluation, a radius of 100 feet or less may be more 
appropriate for the utility pole.  These analyses can be reassessed from the 
inputs form (select Option 1) to save update time. 
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TRAFSAF MACRO: SITE IDENTIFICATION PROCEDURE 
 
The LGSP model returns prioritized local crash sites and relevant details based 
on a number of user inputs.  Data are grouped and manipulated according to a 
series of Access queries that run upon activation of the TRAFSAF macro.  A 
flowchart delineating the order of macro procedures is provided on the following 
pages.   
Activation of the TRAFSAF macro from the INPUTS form will follow the steps 
shown in the table below.  For each step, the purpose of the procedure and the 
data elements involved are identified.  Tables are indicated with a “T:” prefix, 
queries by the “Q:” prefix. 
The following tables shown in the “Type” column of the TRAFSAF query table are 
outputs that AzLGSP writes to the SFTYDATA.mdb file: 

LOCATION 
LOCATION TABLE 
PRIORITY LIST 
PRIORITY DETAIL 
TABLE 2D 
TABLE 3 
TABLE 4   

ERRORS 
In rare cases, certain combinations of input parameters will generate a run time 
error.  An example that occurred during an update for Parker (LaPaz County) 
using the 500-foot aggregation distance is shown below.  

 
The overflow error stops the transfer of data to SFTYDATA.mdb and required 
that the TRAFSAF macro be halted before completion.  The following dialog box 
will appear to prompt that the TRAFSAF macro be halted. 
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Halting the macro is not a problem in itself.  After pressing the “Halt” button in the 
previous dialog box, the program will display the following screen: 

 
Click on the STARTUP:Form bar circled in the figure above.  This will reopen the 
STARTUP page.  From the STARTUP page, proceed to INPUTS (Option #1) and 
change the aggregation distance and/or reporting method for the jurisdiction.  
Re-run the model using the new site selection parameters and the problem 
should be resolved.   
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ARIZONA LGSP MODEL TRAFSAF CLASSIFICATION QUERY 

Query Purpose Elements Type 

Step1 Translate inputs to proper 
jurisdiction(s) T: INPUTS; T:JURIS Select 

Step1b Return all crashes identified in 
Step1 jurisdiction Q: Step1; T:SMS06000 T: LOCATION 

Step1c1 Assign unique identifier 
(On_Road) T:LOCATION; T:SMS13000 Select 

Step1c2 Assign unique identifier 
(At_Road) T:LOCATION; T:SMS13000 Select 

Step2 Return incident-level details for all 
crashes in T: LOCATION 

T:LOCATION; T:SMS01000; 
T:SMS05000; Q:Step1c1;       
Q:Step1c2 

T: 
LocationTable 

Step2a 
Filter locations by Reference 
Method and Aggregation 
Distance 

T:LocationTable;  T:INPUTS Select 

Step2b Restrict Step2a results by Alcohol 
delimiter; summarize records Q:Step2a; T:SMS08000 T: Table2d 

Step3 

Return incident-level results for 
filtered records for 
T:LocationTable, limited by month 
and year filter 

T:LocationTable; T:Table2d; 
T:INPUTS T: Table3 

Step4 
Return unit and person details for 
Table3 records, add crash cost 
estimates by maximum injury 

T:Table3; T:SMS08000; 
T:SMS10000; T:SMS12000; 
T:COMPCOST 

T: Table4 

Step4a Aggregate and annualize Table4 T:Table4; T:INPUTS Select 

Step4a2 Return Step4a maximum values  Q:Step4a Select 

Step5 Create a priority list of locations, 
sorted by user preference 

T:Table3; T:Table4; 
T:INPUTS; T:JURIS; 
Q:Step4a; Q:Step4a2 

T: PRIORITY 
LIST 

Step6 Join and summarize all details for 
each incident in T:PRIORITYLIST 

T:PRIORITYLIST; T:Table3; 
T:Table4; T:SMS04000 

T:PRIORITY 
DETAIL 

DETAIL 
RPT 

Add descriptor fields to T: 
PRIORITY DETAIL 

T:Priority Detail; 
T:LocationTable; Q:01000; 
Q:05000; Q:07000-1; 
Q:07000-2;Q:08000; Q:12000; 
Q:08000-1; Q:08000-2; 
Q:12000-1 

T: 
P_DETAILRPT 
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Arizona LGSP “TRAFSAF” Macro Flowchart 
 

 
 
 

Continued on 
next page 
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TRAFSAF Macro Flowchart (Continued) 

 
 
 
 
 
 
 
 
 
 


